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8EXPOEXPO  
software for solving crystal structures by powder software for solving crystal structures by powder 

diffraction data: methods and applicationdiffraction data: methods and application

Corrado Cuocci
Institute of Crystallography — National Research Council (CNR), Bari, Italy

https://www.ba.ic.cnr.it/softwareic/expo/tutorials-and-lectures/

https://www.ba.ic.cnr.it/softwareic/expo/tutorials-and-lectures/
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Indexing & 
space group 

determination

Structure solution

Rietveld method

unit cell & space group

initial structural model

final crystal structure

Experimental powder diffraction pattern
the biggest challenge

Crystal Structure Determination ProcessCrystal Structure Determination Process

https://www.ba.ic.cnr.it/softwareic/expo/tutorials-and-lectures/

https://www.ba.ic.cnr.it/softwareic/expo/tutorials-and-lectures/
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Methods of Structure SolutionMethods of Structure Solution

Structure
 solution
methods

Traditional approaches:

direct methods
Patterson methods

Direct space methods

Alternative expressions:real space, 
global optimization, global search

Other methods:

charge flipping
molecular replacement
…...............................

https://www.ba.ic.cnr.it/softwareic/expo/tutorials-and-lectures/

https://www.ba.ic.cnr.it/softwareic/expo/tutorials-and-lectures/
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Laboratory of Industrial and 
Synthetic Organic Chemistry 
(LISOC)

Required information

Crystal structure determination by direct methodsCrystal structure determination by direct methods

20 non-H atoms

C
15

H
14

O
4
S

Required information

DM

https://www.ba.ic.cnr.it/softwareic/expo/tutorials-and-lectures/

https://www.ba.ic.cnr.it/softwareic/expo/tutorials-and-lectures/
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cimetidine

Crystal structure determination of cimetidine Crystal structure determination of cimetidine from powder synchrotron 
diffraction data

Required information

C
10

H
16

N
6
S

Required information

DM

See tutorial 1:
https://www.ba.ic.cnr.it/softwareic/expo/tutorials/

https://www.ba.ic.cnr.it/softwareic/expo/tutorials/
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Crystal structure determination of LaCrystal structure determination of La
33TiTi

55AlAl
1515OO3737  

Required information

LaLa
33TiTi

55AlAl
1515OO3737  

Required information

DM

Example included in the folder:
EXPO&more computer sessions EXPO/Solution by Direct Methods/Default

%structure LaTi
%job LaTi from Acta Cryst.(2011).B67,455–460
%data
cell 22.59355 10.99919 9.72968 90 98.5634 90
spacegroup C2/c
content (Al9LaO19Ti2)8
pattern LaTi.rtv
%continue

https://www.ba.ic.cnr.it/softwareic/expo/tutorials-and-lectures/
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All All trialstrials were explored during the Direct  were explored during the Direct 
Methods procedureMethods procedure

Crystal structure solution Crystal structure solution from powder diffraction data from powder diffraction data 
exploring all trialsexploring all trials

C
16

H
22

N
2
O

5

Required information
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Exploring trialsExploring trials
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2-mercaptobenzoic acid

C
7
H

6
O

2
S

Crystal structure solution of 2-Mercaptobenzoic acid Crystal structure solution of 2-Mercaptobenzoic acid 
compound by direct methodscompound by direct methods

All All trialstrials were explored during the Direct  were explored during the Direct 
Methods procedureMethods procedure

See tutorial 2:
https://www.ba.ic.cnr.it/softwareic/expo/tutorials/

C
7
H

6
O

2
S
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Crystal structure determination by direct methodsCrystal structure determination by direct methods

%job cri14 - C15H14O4S
%structure cri14
%data
pattern cri14_data.xy
wave 1.54056
%ntreor
%dicvol
%continue

%job cri14 - C15H14O4S
%structure cri14
%data
pattern cri14_data.xy
wave 1.54056
cell 9.1659 12.5632 11.5473 90.000 101.8688 90.000
space P 21/c
content (C15 H14 O4 S)4
%continue

Input file starting from indexing

Input file when cell and space group
are already known

https://www.ba.ic.cnr.it/softwareic/expo/tutorials/
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Limits of Direct MethodsLimits of Direct Methods

phase III of oxanorbornane
Z'=4, synchrotron data

C polymorph of nifedipine
Z'=2, synchrotron data

tetracycline hydrochloride
Z'=1, synchrotron data

prednisolone succinate
Z'=2, X-ray data
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Global Optimization MethodsGlobal Optimization Methods

Global minimum x*

Local minimum

Local optimization methods Structure refinement

Global optimization methods Structure solution

F:ℝn→ℝFind x*= min{F(x)}, where 

X = fractional coordinates of (x,y,z)       or       

X = position (x,y,z), orientation (θ, φ, ψ), torsion angles (τ
1
, τ

2
, … τ

n
) of molecular fragments

Local minimum
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Global optimization methodsGlobal optimization methods

Deterministic methods
Branch and Bound methods
Cutting Plane methods
Interval methods
…..................

Heuristic strategies
Genetic Algorithms (GA) 
Simulated Annealing (SA)
Tabu Search
Ant Colony Optimization
Particle Swarm Optimization (PS)
Bee Algorithms
Firefly Algorithms
Harmony Search
Big Bang-Big Crunch 
…...............................
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Global optimization methodsGlobal optimization methods

Deterministic methods
Branch and Bound methods
Cutting Plane methods
Interval methods
…..................

Heuristic strategies
Genetic Algorithms (GA)* 
Simulated Annealing (SA)*
Tabu Search
Ant Colony Optimization
Particle Swarm Optimization (PS)*
Bee Algorithms
Firefly Algorithms
Harmony Search
Big Bang-Big Crunch* 
…...............................

(*) employed in solving crystal structure
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Global optimization methodsGlobal optimization methods

Deterministic methods
Branch and Bound methods
Cutting Plane methods
Interval methods
…..................

Heuristic strategies
Genetic Algorithms (GA)* 
Simulated Annealing (SA)*
Tabu Search
Ant Colony Optimization
Particle Swarm Optimization (PS)*
Bee Algorithms
Firefly Algorithms
Harmony Search
Big Bang-Big Crunch* 
…...............................

(*) employed in solving crystal structure

Widely used and with 
the largest impact

 
Various modifications: 

parallel tempering (PT)
adaptive simulated annealing
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Global optimization methodsGlobal optimization methods

Deterministic methods
Branch and Bound methods
Cutting Plane methods
Interval methods
…..................

Heuristic strategies
Genetic Algorithms (GA)* 
Simulated Annealing (SA)*
Tabu Search
Ant Colony Optimization
Particle Swarm Optimization (PS)*
Bee Algorithms
Firefly Algorithms
Harmony Search
Big Bang-Big Crunch* 
…...............................

(*) employed in solving crystal structure

Widely used and with 
the largest impact

 
Various modifications: 

parallel tempering (PT)
adaptive simulated annealing

Software **: DASH (SA), EXPO (SA), 
ENDEAVOUR (SA), FOX (PT), GEST (GA), 
PeckCryst (PS), PowderSolve (SA), PSSP (SA), 
TOPAS (SA), …       

commercial software are in red
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-Chemical knowledge is not 
necessary

+Can incorporate a massive amount of 
prior chemical information

Comparison between the two methodsComparison between the two methods
Traditional approaches Direct space methods

Clegg, W. & Teat, S. J., (2000). Acta Cryst. C56, 1343-1345.

+Complexity of procedure depends on 
the number of degrees of freedom (DoF). 

+High resolution is not needed.  
Default resolution: 2-2.5 Å.

-Take time and patience. For large 
molecules: faster computer, run 
overnight, parallel program

-Complexity of the problem depends 
on the number of non H-atoms in the 
a.u.

-Take advantage by using data of 
higher resolution

+Generally require less time to run

tetracycline (32 non-H atoms and 8 DoF) can 
be solved using global optimization
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Building starting modelBuilding starting model

It is necessary to know the molecular connectivity. 
Spectroscopic techniques (MS, NMR) can be useful 

Crystal structure can be described as a combination of building blocks

atom molecule polyhedron
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Building starting modelBuilding starting model

Check for similar molecules in databases or in the 

literature

Optimize molecular geometry by computational chemistry 

programs
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Crystal Structure DatabasesCrystal Structure Databases**

CSD (Cambridge Structural Database) (organics & organometallics):

http://www.ccdc.cam.ac.uk/

ICSD (Inorganic Crystal Structure Database) 

(inorganics, elements, minerals & intermetallics): http://icsd.ill.fr/

COD (Crystallography Open Database) (general database): 

http://www.crystallography.net/

Other databases: ICDD PDF-4+, American Mineralogist Crystal Structure 
Database,  MINCRYST, Zeolite Structures Database, ... 

Non-commercial databases are in red

File format: CIF (Crystallographic Information File)

*Joint special issue: Acta Cryst. B58, 317-422 (2002)
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Free Chemistry DatabasesFree Chemistry Databases

PubChem: https://pubchem.ncbi.nlm.nih.gov/

NIST Chemistry WebBook: http://webbook.nist.gov/chemistry/

Drugbank: http://www.drugbank.ca/

Other databases: ZINC, eMolecules, ChEBI, NMRShiftDB, ...

Chemical file formats: sdf, mol, mol2, 
cml, SMILES, ...

http://www.ba.ic.cnr.it/ochemdb/
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Load crystal structures from COD

“File” menu →  “Import Fragment” menu →  “From COD”

“Modify” menu → “Add Fragments” menu → “From COD”

“View” menu →  “Jav Molecular Viewer”
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Three levels of theory

Molecular-mechanics force fields (MM) 

Semi-empirical methods (SE)

Ab initio methods: Hartree–Fock methods, density 
functional theory (DFT)

Strategy: MM → SE → DFT

Geometry optimizationGeometry optimization
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obmodule.f90

The Use of Open BabelThe Use of Open Babel

EXPO2014 Open Babel

Fotran/C++ C++

Molecular-mechanics force fields (MMFF99 
and UFF provided by Open Babel library)

Able to process input and output files of 
common quantum-chemistry packages: 
GAMESS-US, NWChem, Gaussian, 
CRYSTAL, ABINIT, Quantum ESPRESSO 
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Graphical User Interface for MOPAC2016

Geometry optimization by MOPAC

MOPAC2016™ is a semiempirical quantum chemistry software package available FREE 
for academic, not-for-profit use. Download link: http://openmopac.net/downloads.html

http://journals.iucr.org/c/issues/2000/11/00/bm1422/index.html
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Molecule editorMolecule editor

Sketch molecules in 2D or 3D format 

Optimize the geometry by force field method 

Create input file for the quantum-chemistry calculations 

Read output files of the most common computational packages 

ACD/ChemSketch -  http://www.acdlabs.com 

Avogadro - http://avogadro.openmolecules.net/wiki/Main_Page

MarvinSketch -  http://www.chemaxon.com/products/marvin/

Gabedit: http://gabedit.sourceforge.net/

Some free available software

A molecule editor allows
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Building starting modelBuilding starting model

3D structure optimization

P 21/a

2-(4-Hydroxy-2-oxo-2,3-dihydro-1,3-benzothiazol-7-yl)
ethylammonium chloride N

frag
 = 2

N
dof

 = 6 + 3 + 2

Save as 
.mol, .mol2,
.fhz, .mop, 
.cif, .pdb, .frac
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Building starting model: example 2Building starting model: example 2

P2
1

N
frag

 = 2
N

dof
 = 6 + 6 + 4 + 4

 S-Ibuprofen

Two molecules in the a.u. (Z’=2)

3D structure 
optimization

Duplicate

Save as 
.mol, .mol2,
.fhz, .mop, 
.cif, .pdb, .frac

http://icsd.ill.fr/
http://www.crystallography.net/
https://journals.iucr.org/b/issues/2002/03/01/
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Crystal structure solution of ibuprofenCrystal structure solution of ibuprofen by direct space method by direct space method

C
13

H
18

O
2

Ibuprofen

https://pubchem.ncbi.nlm.nih.gov/
http://webbook.nist.gov/chemistry/
http://www.drugbank.ca/
http://www.ba.ic.cnr.it/ochemdb/
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Using expo2014 for direct-space structure solutionUsing expo2014 for direct-space structure solution

By input file (*.exp)By input file (*.exp)

%Structure ibuprofen
%Job ibuprofen - C13H18O2
%Data
   Cell  14.6682 7.8933 10.7323 90 99.4092 90
   SpaceGroup p 21/c
   Pattern   ibuprofen.dat
   Wavelength 1.54056
%fragment ibuprofen.mol
%sannel

File → Load and Go

Command-line usageCommand-line usage
expo ibuprofen.exp
or
expo ibuprofen.exp –nogui
or
expo ibuprofen.exp –auto  

Usage of the command %fragment
%fragment tetra AtC AtV [dist]
%fragment octa AtC AtV [dist]
%fragment square AtC AtV [dist]
%fragment cube AtC AtV [dist]
%fragment trigonal AtC AtV [dist]
%fragment prism_tetra AtC AtV [dist]
%fragment prism_trig AtC AtV [dist]
%fragment icosa AtC AtV [dist]
%fragment atoms chem_formula
%fragment smiles SMILES_string

ibuprofen.mol
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Using expo2014 for direct-space solutionUsing expo2014 for direct-space solution

File → Import Diffraction Pattern 

Solve → Simulated Annealing

By graphical interface

Modify → Add Fragments

File → Import Structure
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Building starting model: example 3Building starting model: example 3

P 21/a

3D structure optimization

1,4-Bis(2-phenethyloxyethanesulfonyl)piperazine

center of symmetry a.u. is a half molecule
Z’ = 1/2

Structure solution
by DSM + DOC

N
dof

 = 6 + 14

15 times slower

Structure solution
by DSM

N
dof

 = 6 + 7
Recommended 

strategy
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Building starting modelBuilding starting model

Stereochemistries will not be altered during simulated annealing.
Pay particular attention to compounds with more than one chiral center and cis/trans isomerism

Pay attention to non planar ring systems or unusual combinations of elements in functional
groups. Check for similar molecules in the CSD or in the literature

or or

trans cis

http://openmopac.net/downloads.html
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H atomsH atoms

H atoms do not contribute significantly to X-ray diffraction, they 
can be ignored during the structure solution

Eliminating the H atoms reduces the number of atoms and DoFs, 
decreasing the time to evaluate CF for each trial structure

Delete H atoms using 
the GUI or using the 
deletehydro directive

http://www.acdlabs.com/
http://avogadro.openmolecules.net/wiki/Main_Page
http://www.chemaxon.com/products/marvin/
http://gabedit.sourceforge.net/
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Hydrogen calculationHydrogen calculation

Hydrogen atoms are positioned 
geometrically at X-ray distances

0.82 Å (X-ray) 

X-H (X-ray) < X-H (neutrons)

0.95 Å (neutrons) 
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Cost function

Starting temperature

Temperature reduction factor

Number of moves  

Number of SA runs

Resolution

Random seed

Simulated annealing optionsSimulated annealing options
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Cost function

Starting temperature

Temperature reduction factor

Number of moves  

Number of SA runs

Resolution

Random seed

Simulated annealing optionsSimulated annealing options

● No. of molecular fragments
● No. of external DoFs
● No. of internal DoFs
● The flexibility of the molecule
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Cost Functions

● Whole profile R factor 

● Integrated intensities R factor 

● Other cost functions: 
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Molecular compoundsMolecular compounds

Paracetamol (form I polymorph) 
(C

8
H

9
NO

2
) *

*Nichols, C. & Frampton, C. S. (1998). J. Pharm. Sci. 87, 684–693.
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Non-molecular compoundsNon-molecular compounds

Crystal structure of Sb
2
(PO4)

3 
*

*Jouanneaux, A., Verbaere, A., Guyomard, D., Piffard, Y., Oyetola, S. & Fitch, A. N. (1991). Eur. J. Solid State Inorg. Chem. 28, 755-765.
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Non-molecular compoundsNon-molecular compounds

Sb
2
(PO

4
)

3N
dof

 = 51

N
dof

 = 30

N
dof

 = 24
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Non-molecular compoundsNon-molecular compounds

Some atoms are expected to fall on special positions

Different building blocks share some atoms

You cannot know the number and the type of the polyhedra
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Dynamical occupancy correction (DOC)Dynamical occupancy correction (DOC)

Falcioni, M. & Newsam, J. M. (1989). Nature 342, 260-262.

Favre-Nicolin, V. & Černỳ, R.  (2002). J. Appl. Cryst.. 35, 734-743

o
cc

u
p

an
cy

DOC is able to merge the excess atoms automatically
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Dynamical occupancy correction (DOC)Dynamical occupancy correction (DOC)

doc

or

doc atom1 atom2 ... 
doc Ni1
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Dynamical occupancy correction (DOC)Dynamical occupancy correction (DOC)

DOC slows down the computation time so it should be DOC slows down the computation time so it should be 
avoided if no special positions or shared atoms are expected.avoided if no special positions or shared atoms are expected.
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SA applied to non-molecular compoundsSA applied to non-molecular compounds
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SA applied to non-molecular compoundsSA applied to non-molecular compounds

Sb
2
(PO

4
)

3

Polyhedra rapresentation of Sb
2
(PO

4
)

3 
 

by SA with DOC

SA with DOCSA with DOC
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Delete duplicate atomsDelete duplicate atoms

29 atoms

2 atoms

2 atoms

2 atoms

17 atoms

*

symmetry equivalent atoms *

1.  Modify > Delete Duplicate Atoms
2. Tools > Build Bonds

2 atoms *
*

*
*

*

*

*
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Direct Space with Low Quality Diffraction Pattern

Bond valence restraints Bond valence restraints 

Anti-bumping restraints Anti-bumping restraints 

Molecular geometry restraintsMolecular geometry restraints

http://www.sciencedirect.com/science/article/pii/S002235491550590X?via%3Dihub
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Imposing anti-bumping restraints Imposing anti-bumping restraints 

All nonbonded interactions between 
atoms that are separated by a path of 
bonds containing 4 rotable bonds or 
less are excluded

Only 1-5 interactions are considered
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Imposing anti-bumping restraints Imposing anti-bumping restraints 

%sannel
bscale 0.9
bump * *
nobump Ag1 N1
nobump Ag1 N2

[Ag(pz)]
n 
Hpz = pyrazole

Warning: time-consuming procedure, use only 
if the diffraction data are not of sufficient quality

Directive: 

bump

bump atoms1 atoms2 [dist]

or
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Bond Valence Restraints Bond Valence Restraints 

Atomic valence V
i
 of atom i in crystal structure is the sum of individual bond valences S

ij

distance between atoms i and j

bond valence parameters (bvparmyyyy.cif maintened by I.D. Brown and 
available from http://www.iucr.org/resources/data/datasets/bond-valence-parameters)

The estimated values V
i
 can be incorporated as restraints in the cost function (*): 

* J. Pannetier, J. Bassas-Alsina, J. Rodriguez-Carvajal & V. Caignaert, (1990). Nature 346, 343 - 345

global-instability index
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Check Bond Valence SumCheck Bond Valence Sum
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    = distance between two atoms A and B

= ideal distance

= permitted tolerance

= user supplied weight

Molecular Geometry RestraintsMolecular Geometry Restraints

Rarely improves the success rate of the solution search for good quality data

Restraints can slow or prevent a structure solution process

Directive: 

rest  A  B  d
target

  tol

d
target 

and tol are optional: 

rest  A  B
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Non planar ring systems

Paying attention to non planar ring systems or unusual combinations 
of elements in functional groups
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Structure Solution of Diltiazem HydrochlorideStructure Solution of Diltiazem Hydrochloride**

DSM
DOF = 6+3+7

DS
DOF = 6+3+12

Published

DSM

CF = 14.06
RMSD=0.275 Å 

NO SOLUTION!

Geometry optimization by DFT
(NWchem, B3LYP/6-31G*)

*Kojic Prodic, B., Ruzic Toros, Z., Sunjic, V., Decorte, E. & Moimas, F. (1984). Helv. Chim. Acta, 67, 916–925.
https://doi.org/10.1002/hlca.19840670333
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8%Structure diltia
%Job CSD refcode: CEYHUJ01

%Data
Cell   42.190  9.075  6.037  90  90  90
SpaceGroup p 21 21 21
Pattern    pd_0029.xy
Wavelength 1.54056

%fragment diltiazem_nw_break.mol
%fragment atoms Cl
deletehydro

%sanneal
nrun 100
niter 5000

Structure Solution of Diltiazem HydrochlorideStructure Solution of Diltiazem Hydrochloride

File: diltia.exp
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8%Structure diltia
%Job CSD refcode: CEYHUJ01

%Data
Cell   42.190  9.075  6.037  90  90  90
SpaceGroup p 21 21 21
Pattern    pd_0029.xy
Wavelength 1.54056

%fragment diltiazem_nw_break.mol
%fragment atoms Cl
deletehydro

%sannel
nrun 100
niter 1000
rest C4 C5

Structure Solution of Diltiazem Hydrochloride Structure Solution of Diltiazem Hydrochloride 
(approach with restraint)(approach with restraint)

File: diltia_res.exp
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 BALLOON

 CONFAB

 FROG2

 RDKit

 CORINA

 MOE

 OMEGA

Combining conformational analysis with DSM

Conformer Generator DSM
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Conformer Generation with RDKit

ETKDG

cd ~/anaconda3/bin/
source activate my-rdkit-env

https://github.com/iwatobipen/rdk_confgen
Change line param = rdDistGeom.ETKDGv2() (line 16) 
in param = rdDistGeom.ETKDGv3()

confgen --input diltia_nw.mol --numconf 100 

obabel gen_confs.sdf -O diltia1.mol -m

 RDKit environment must be activated

 Simple script for generating conformers from single molfile

 RDKit environment must be activated

 Then run confgen command

 Split SDF file into single MOL files
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#!/bin/bash

filein=molecules.txt
template=diltia_templ

rm results.dat summary.dat *.expo *.bin *_best*.cif
c=`wc -l $filein | awk '{print $1}'`

for i in `seq 1 $c`;
do
a=`cat $filein | head -$i | tail -1`
file=${a%.*}
echo $file $template
sed "s%STRNAME%$file%" $template > "$file.exp"
#expo "$file.exp" "$file.out" --nogui
mpirun -np 20 $HOME/expo/expo_mpi "$file.exp" "$file.out"
echo "=======================================" >> results.dat
echo "$file.out" >> results.dat
grep @@  "$file.out" | cut -c3-  >> results.dat
grep --with-filename @@best "$file.out" | sed 's/:@@best//g' 
>> summary.dat
done

Running a structure solution process on each estimated conformer



  

N
an

E
D

 W
or

ks
h

op
 I

I -
 U

ni
ve

rs
ity

 M
ai

nz
, D

ec
em

be
r 

6
.-

8

#!/bin/bash

filein=molecules.txt
template=diltia_templ

rm results.dat summary.dat *.expo *.bin *_best*.cif
c=`wc -l $filein | awk '{print $1}'`

for i in `seq 1 $c`;
do
a=`cat $filein | head -$i | tail -1`
file=${a%.*}
echo $file $template
sed "s%STRNAME%$file%" $template > "$file.exp"
#expo "$file.exp" "$file.out" --nogui
mpirun -np 20 $HOME/expo/expo_mpi "$file.exp" "$file.out"
echo "=======================================" >> results.dat
echo "$file.out" >> results.dat
grep @@  "$file.out" | cut -c3-  >> results.dat
grep --with-filename @@best "$file.out" | sed 's/:@@best//g' 
>> summary.dat
done

Running a structure solution process on each estimated conformer

diltia1.mol
diltia2.mol
diltia3.mol
diltia5.mol
diltia4.mol
diltia8.mol
diltia7.mol
diltia6.mol
diltia9.mol
diltia11.mol
diltia10.mol
diltia15.mol
diltia14.mol
diltia13.mol
diltia12.mol
diltia20.mol
...

https://www.nature.com/nature/journal/v346/n6282/abs/346343a0.html
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#!/bin/bash

filein=molecules.txt
template=diltia_templ

rm results.dat summary.dat *.expo *.bin *_best*.cif
c=`wc -l $filein | awk '{print $1}'`

for i in `seq 1 $c`;
do
a=`cat $filein | head -$i | tail -1`
file=${a%.*}
echo $file $template
sed "s%STRNAME%$file%" $template > "$file.exp"
#expo "$file.exp" "$file.out" --nogui
mpirun -np 20 $HOME/expo/expo_mpi "$file.exp" "$file.out"
echo "=======================================" >> results.dat
echo "$file.out" >> results.dat
grep @@  "$file.out" | cut -c3-  >> results.dat
grep @@best  "$file.out" | cut -c3-  >> summary.dat
done

Running a structure solution process on each estimated conformer
%Structure STRNAME
%Job CSD refcode: CEYHUJ01

%Data
Cell 42.190  9.075  6.037  90  90  90
SpaceGroup p 21 21 21
Pattern    pd_0029.pow
Wavelength 1.54056

%fragment STRNAME.mol
%fragment atoms Cl
deletehydro

%sanneal
nrun 20

%save STRNAME.expo
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#!/bin/bash

filein=molecules.txt
template=diltia_templ

rm results.dat summary.dat *.expo *.bin *_best*.cif
c=`wc -l $filein | awk '{print $1}'`

for i in `seq 1 $c`;
do
a=`cat $filein | head -$i | tail -1`
file=${a%.*}
echo $file $template
sed "s%STRNAME%$file%" $template > "$file.exp"
#expo "$file.exp" "$file.out" --nogui
mpirun -np 20 expo_ompi "$file.exp" "$file.out"
echo "=======================================" >> results.dat
echo "$file.out" >> results.dat
grep @@  "$file.out" | cut -c3-  >> results.dat
grep --with-filename @@best "$file.out" | sed 's/:@@best//g' 
>> summary.dat
done

Running a structure solution process on each estimated conformer
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Analysis of the results

RMSD = 0.1547 Å 
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The crystal structure of tetracycline hydrochloride

DOF = 6 + 3 + 2

https://doi.org/10.1002/hlca.19840670333
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Supercomputers Marconi by CINECA  (Italy)
244.800 cores in total

Notebooks Typically 2-8 cores

Smartphones Typically 2-10 cores

Workstations
Typically 4-56 cores

Graphical Processing Units Up to 3000 cores

Parallel Machines
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Parallelization Strategies

Message Passing Interface (MPI)

Open MultiProcessing (OpenMP)

Compute Unified Device Architecture (CUDA)

Distributed-memory architecture

Shared-memory architecture

CPU-Based Parallelization Strategies

GPU-Based Parallelization Strategies

Open Computing Language (OpenCL) 

OpenACC

Open Computing Language (OpenCL) 
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Message Passing Interface (MPI)

mpirun -np 3 expo input_file.exp

Time

0: expo2014
4 runs

3 runs

3 runs

MPI barrier

1: expo2014

2: expo2014
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Running the Parallel Version of EXPO2014

Computer with multi-core CPUs and Linux environment.

MPI installed.

Compiling EXPO2014 from source and linking with MPI libraries

Run Expo2014 by using the launcher mpirun with the appropriate options.

mpirun -np 10 expo input_file.exp

Intel(R) Core(TM) i7-8700 CPU @ 3.20GHz

T
im

e 
(m

in
.)

https://github.com/iwatobipen/rdk_confgen
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Running parallel version of EXPO2014 on Windows

Download and installation

http://www.ba.ic.cnr.it/softwareic/expo/parallelism-in-expo2014-for-structure-solution-by-direct-space-method/

Windows Subsystem for Linux (WSL)
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DOF
Internal: 20
External: 6

Algorithm settings
NRUN: 100
NITER: 1000

Time
Single CPU-core: 500 h 
20 CPU-cores: 25 h
Parallel speedup: 20

Z-(Aib)
5
-O-t-Bu

Structure solution of small peptide

E. Benedetti, A. Bavoso, B. Di Blasio, V. Pavone, C. Pedone, M. Crisma, G. M. Bonora, and C. Toniolo, J. Am.Chem. 
Soc. 104, 2437 (1982)

Published

DSM

RMSD=0.2113 Å 
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%structure vohvia

%data
pattern VOHVIA.cif
cell 37.96347 6.110426 22.47454 90 98.3273 90
space P21/c

%fragment vohvia_mopac.mol
%fragment vohvia_mopac.mol
deletehydro

%sannel
nrun 100
niter 2000
resm 2.5

Structure solution of selexipag form I

DOF: 6+6+13+13 = 38
Time: ~45h on 25 CPU-cores (2.90 GHz)
RMSD: 0.3234 Å  

Reference
Successful Strategy for High Degree of Freedom Crystal Structure Determination from Powder X-
Ray Diffraction Data: A Case Study for Selexipag Form I with 38 DOF
Michal Hušák, Alexandr Jegorov, Jiri Czernek, Jan Rohlíček, Simona Žižková, Pavel Vraspír, Pavel Kolesa, Andrew 
Fitch, and Jiri Brus

Cryst. Growth Des. 2019, 19, 8
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Assessing the solutionAssessing the solution

Reproducibility of solution

Agreements factors
Visual match between the calculated and observed profile
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Assessing the solutionAssessing the solution

Crystal packing

Network of interactions: hydrogen bonds and short contacts

Check close contacts, void spaces, likely interactions
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Optimization of the molecular geometry to obtain accurate starting models

Restraints in the Rietveld refinement

H atoms

Refinement of crystal structure

Solve ambiguities 
(e.g., space groups, torsion angles)

Validation of experimental crystal structures

Combined powder X-ray diffraction data and Combined powder X-ray diffraction data and 
quantum-chemical calculationsquantum-chemical calculations

Two possible orientations of the pyridyl ring in the 
piroxicam molecule (Naelapää, K., van de Streek, J., 
Rantanen, J., and Bond, A. D. (2012), 
J.Pharm. Sci. 101, 4214–4219)
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Assessing the solution with DFT-DAssessing the solution with DFT-D

Theoretical approach: plane wave (PW) density functional theory with 
dispersion correction (DFT-D)

RMSD for non H-atoms above 0.35 Å could indicate incorrect experimental 
crystal structure *

*Jacco ven de Streek et al. Validation of molecular crystal structures from powder diffraction data with dispersion-corrected
density functional theory (DFT-D) Acta Cryst. (2010). B66, 544–558

Experimental crystal structure

DFT-D3 with NWChem

Ibuprofen

RMSD=0.091 Å 
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Software Academic price (€) Link

VASP 4,000 www.vasp.at

CASTEP 1,800 www.castep.org

CRYSTAL 1,000 www.crystal.unito.it

Quantum ESPRESSO free www.quantum-espresso.org

NWChem free www.nwchem-sw.org

Abinit free www.abinit.org

Hardware: multi-core Linux Workstation

Time: approx. 100 hrs for small molecules on single CPU

DFT-D: HowtoDFT-D: Howto
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Starting model is incorrect: 
chemical formula is wrong
bond distance and angle are not entirely accurate
number of building blocks is wrong
missing solvent
  …................  

Check the compositional information (MS, SEM/EDS, XRF, ICP, NMR)
Try different combination of building blocks
Check the molecular stereochemistry, or ring conformation
Improve your model with CSD or building packages
Use the SS-NMR to deduce the number of molecules in the asymmetric 
unit (Z’) 

Solution:Solution:

When Structure Solution FailsWhen Structure Solution Fails



  

N
an

E
D

 W
or

ks
h

op
 I

I -
 U

ni
ve

rs
ity

 M
ai

nz
, D

ec
em

be
r 

6
.-

8

Poor quality diffraction pattern

When Structure Solution FailsWhen Structure Solution Fails

Collect new data
Add restraints or anti-bump restraints

Systematic problem in powder diffraction data

Solution:Solution:

Collect new data
Refine preferred orientation parameters

Solution:Solution:

Preferred orientation
Kα2 contributions
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When Structure Solution FailsWhen Structure Solution Fails

For complex structure (internal DOF > 10) the default SA conditions could 
be insufficient

Solution:Solution:
Increase the number of moves (niter 
directive) and/or runs (nrun directive)

The assumptions about thermal factors are invalid 

Solution:Solution:
Try altering the non-hydrogen atom temperature factors
Check temperature factors for similar structures

http://www.ba.ic.cnr.it/softwareic/expo/parallelism-in-expo2014-for-structure-solution-by-direct-space-method/
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When Structure Solution FailsWhen Structure Solution Fails

Space group and cell are not correct

Solution:Solution:
It may be necessary to carry out a series of independent calculations 
to test different potential space groups and/or unit-cell choices
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Contact, software download and info
http://www.ba.ic.cnr.it/softwareic/expo/
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